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About this book 
 

Greetings, 

 

I would like to this book MetaTrader 4 for Dummies. I’m Liam O’Brien 

the founder of the MetaTrader Global portal. 

 

What is MetaTrader Global? 

MetaTrader Global is world’s leading website portal dedicated to. I 

am committed to providing current relevant information to our 

members relating to MetaTrader. 

 

About Liam 

I have been involved with MetaTrader and financial markets for 

number of years from managed accounts, neural network 

programmed trading, expert advisors research, general trading and 

more. When I came across MetaTrader I was by no means new to 

trading, I was actually prop trading for a private syndicate. This now 

is my 9th year involved with the markets. 

 

I really hope you find this website portal a useful resource for 

MetaTrader. I wish you all the best with your trading. 

 

Liam O’Brien 
Website: www.MetaTraderGlobal.com 

Sitemap: www.MetaTraderGlobal.com/sitemap/ 

Twitter: http://twitter.com/MetaTraderLive/ 

Email: info@metatraderglobal.com 
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Introduction to MetaTrader 4 

About MetaTrader 4 

The MetaTrader 4 (MT4) platform is possibly the most recognized and efficient home 

broker trading application nowadays on the market. It is free and available for 

download from the MetaQuotes Software Corporation website, the producer of 

MetaTrader 4. If your broker offers the possibility of having MT4 as your main 

trading platform, it will be likely to provide a download link directly when you sign up 

for your trading account. Even if many brokers have their own platforms, MT4 it is 

still a powerful and reliable tool for Forex, stock, and commodity traders. If your 

broker doesn’t support MT4, you can freely access real data from several servers on 

MT4, the currency pair rates differ a bit from MT4 servers and your broker, but it is 

not something that will significantly affect your trading performance. 

 

Once you have successfully downloaded and installed the MT4 software, launch it. It 

may seem a bit complex for beginners, but all the information is very clear and 

divided by windows that allow you to control all your orders and a different number 

of pairs simultaneously. From the Market Watch feature, normally positioned on the 

top left size, under the menu bar, you have all the pairs available on the server, and 

with a click and drag mouse movement you can make that pair to appear in any of 

your chart windows, making it easier and faster to switch from one pair to another, 

and you, as trader, know how decisive can time be, when you have more than one 

order opened, mainly during news and market events. 

 

One of the best features that MT4 offers is the option to create templates that fit 

better each and every trader needs. The profiles can have one or multiple charts. For 

example, 3 EUR/USD charts with different timeframes, or 3 different pair charts, in 

which you can totally customize them using the indicators of your choice. From 

colours to templates, the MetaTrader 4 offers the trader full interaction with his 

orders, which is often not possible in many broker platforms. 

 

Finally MetaTrader 4 is, doubtlessly, a tool that every Forex trader should at least 

download and be familiar with, in most of the cases, you will make it part of your 

trading experience, considering its features, for the moment, MT4 has a wide 

superiority against other trading software. 
Source: http://forex-trading4you.blogspot.com/2009/04/introduction-to-metatrader-4.html 
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MetaTrader 4 - The Traders Choice 

In order to trade from a computer you will need a trading platform. MetaTrader 4 

will execute your trades with your broker and provide you with all the information 

and tools you need to make the trading decision. 

 

There are many different platforms to choose from and selecting the right one is 

clearly important. Most of these platforms are tied to individual brokers so you need 

to consider the broker themselves very carefully. 

 

However there is an alternative. There are independent companies that have 

developed trading platforms who have then partnered with multiple brokers so that 

their system can be traded with the brokers platform. 

 

The best known of these is MetaTrader 4. 

 

What are the advantages of MetaTrader 4? 

� It’s Free; and considering how powerful the software is, that’s excellent news. 

� It provides a comprehensive suite of tools to help you make your trading 

decisions. 

� Customizable – can create your own indicators and trading tools. It has a built 

in programming language which allows you to create your own indicators and 

automated trading robots. 

� Over 300 brokers around the world use this platform. 

� Real time data feed to all major FOREX pairs and with some brokers providing 

commodities, indices and stocks and shares data as well. 

� Will work on Microsoft windows powered mobiles. 

� You can practice with virtual money using the tool. Most brokers will provide 

you with a dummy account in order to test out ideas. 

� Full back testing facilities so you can test your own strategies. The software 

provides years of data for you to test out strategies. 

� Huge amount of information available on the internet. 

 

How do you access the tool? 

There are over 300 brokers throughout the world that allow you to download the 

tool, create and account, and allow you to trade. To find your closest broker visit 

http://www.metatraderglobal.com/global-sites/  
Source: http://forexforbeginnersblog.com/?p=202 
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MetaTrader 4 Basics 

MetaTrader 4 Toolbars 

So you have opened a demo account or live trading account and you have 

downloaded Metatrader 4. What's next? Start trading! But before you can do that 

you need to create your first chart.  

 

Here are the steps. 

 

Select New Chart from the tool bar or from the File drop down menu. Choose the 

currency pair from the list shown. The one hour (H1) chart will be shown by default. 

Click the Candlestick to display chart in candlestick. 

  

 
 

Right click anywhere in the chart and select Properties from the dropdown menu. 

You can change the colours and other settings for the chart to suit your liking. 
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You can add objects and technical indicators to your chart. 

Save your chart as a new Profile with a unique name or it will take the Default name. 

 

 

To make it easier for you, below are description of the various toolbars of 

Metatrader 4. 

 

There are 3 main toolbar groups so I’ll just name them as Windows, Charts and 

Objects for easy reference and refer to each individual tool by an initial and a 

number thus W1, C2, O3, etc. in order of their appearance in the toolbar. 
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Windows Toolbar 

 

 
  

W1 New Chart. Use this to create a new chart. Click on this and a list of 6 major 

currency pairs will appear with some additional pairs under MiniForex. The 

number of additional currency pairs differs from demo account to live accounts. 

Click on the pair you want and a new chart will appear in a new window. 

W2 Profiles. A profile is a chart with all its objects and indicators or a collection of 

several charts. The Default profile will load the first time MT4 is opened and any 

changes made will be saved as the Default profile and open the next time unless 

you save the changes with a new Profile name. You can create and remove 

profiles as you wish and switch to any Profile saved but the Default Profile 

cannot be deleted. 

W3 Market Watch. Click on this and the list of currency pairs available with the bid 

and ask prices will appear in a vertical window on the left. Double click on any 

currency pair and the Order window will open. 

W4 Data Window. Click on this and a window will appear on the left. Move your 

cursor to any candle in a chart and all the data available of the candle will 

appear. 

W5 Navigator. Click on this a window will appear on the left. Here you can select 

your account, indicators (technical), custom indicators, expert advisor and the 

scripts to be run. 

W6 Terminal. Click on this and a new window will appear at the bottom. Here you 

see your trade, the account history, news, mailbox, etc. 

W7 Click on this and a new window will appear at the bottom. This is for testing the 

Expert Advisors. 

W8 New Order. Click on this, the Order window will appear, just like pressing F9. The 

currency pair shown will be the one in the current active chart. 

W9 Meta Editor. This will open a new window to edit, Expert Advisors, custom 

indicators and scripts. For programmers only. 



MetaTrader 4 For Dummies – www.MetaTraderGlobal.com 

9 

 

W10 Expert Advisors. Click on this to enable or disable the Expert Advisors. 

 

Opened windows can be closed by clicking the close window icon, i.e. the x. 

 

Charts Toolbar 

 

 
  

C1 Bar Chart 

C2 Candlestick Chart 

C3 Line Chart. Click on any of these will change the type of the active chart. 

C4  Zoom In 

C5 Zoom Out. Click to zoom in or zoom out the chart as desired, there are 5 levels of 

Zoom. 

C6 Auto Scroll. If selected, the latest bar will always be shown on the screen. To see 

older bars, deselect this. 

C7 Chart Shift. Select this to shift the chart to the shift label (a small grey triangle in 

the upper part of the window). 

C8 Indicators. You can click this to select any indicators instead of using the Navigator 

window. 

C9 Periods. You can select the period of the active chart from 1 minute (M1) to 

Monthly (MN). You can also do this by clicking on the Period Toolbar. 

C10 Templates. Click on this to load, save or delete templates as desired. 

 

Items added to a chart are either Objects or Indicators. The Object Toolbars shows 

the tools available. 
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Object Toolbar 

 

 
  

O1 Cursor. This is the standard arrow cursor by default for selecting items. 

O2 Crosshair. Select Crosshair. Move to active chart window and select first point. 

Press and hold down left mouse button and move to second point. A line 

connecting the two points will be drawn and the data between the two points 

will be shown as number of bars/number of pips/price at the second point. 

Release the left mouse button and all will disappear. 

O3 Vertical Line. Select tool, place at desire position. To make changes, double click 

to select line and handles (two small white squares) will appear. You can drag to 

new position or right click near line to access line properties to make changes. 

Double click after making changes to remove handles. For placing line at a 

particular time. 

O4 Horizontal Line. Same as above but for drawing horizontal line. Usually for 

drawing Support and Resistance levels. 

O5 Trendline. For drawing a slanting or trend line. Select tool. Place at first point, 

hold down left mouse button and select second point for the line. Trend line will 

snap to nearest point. To check if proper point is selected, double click to show 

the handles. There will be three handles, the middle one can be dragged to 

move the whole line while the handles at the two ends are attached to the ends 

of candles and they can be moved so that they snap and attached automatically 

at the ends of a candle. 

O6 Equidistant Channels. The usage is almost the same as O5 drawing the Trendline 

except that a second line is drawn parallel to the first line. Double click on the 

lines to select it and shows the handles. There will be three for the initial line 

(just like the Trendline above) and one handle for the second parallel line. Drag 

this handle by holding down the left mouse button and snap it to the desired 

extreme point and you will have a channel. 

O7 Fibonacci Retracement. Click on this tool and select the first point. Hold down the 

left mouse button and select the second point. It will snap into position and the 

Fibonacci retracement lines will be drawn. Select the main line and there will be 
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three handles just like the trendlines and you can make similar adjustment by 

dragging the handles. 

O8 Text. Select this tool and you can place text anywhere in the active chart. This is 

attached to the chart and will move with the chart. 

O9 Text Label. Select this tool and you can put a label anywhere in the active 

window. This is attached to the window and will not move when the chart is 

scrolled. 

O10 Arrows. Select this to inset not just arrows but other graphical signs in the 

charts. 

 

Finally there is the Period Toolbar which you click to select the timeframe from one 

minute (M1) to monthly (MN). 
Source: http://metatrader4forextrading.blogspot.com/2009/03/metatrader-4-toolbars.html 

 

 

Open or Close a Position 

In order to enable the ‘Order’ window: 

 

1. Right-click on the ‘Market Watch’ window or on the ‘Trade’ tab of the 

‘Terminal’ window and select New order from the context menu; or  

2. Press the F9 button; or  

3. Use the Tools -> New Order menu sequence; or  

4. Right click on the chart window and select Trading -> New Order from the 

context menu; or  

5. Double click on the currency pair in the ‘Market Watch’ window.  

 

 
 

Before you make a deal you can change its details in the ‘Order’ window: 

 

� Symbol - a currency pair or CFD you choose to make a deal.  

� Volume - number of lots.  
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� Stop Loss - the level of Stop Loss order.  

� Take Profit - the level of Take Profit order.  

� Comment - any notes. 

 

Once the "Buy" or "Sell" button is pressed the broker then confirms the deal, you can 

consider your new long or short position open. 

 

 
 

 

In order to close a position, highlight it in the ‘Trade’ tab of the ‘Terminal’ window 

and right-click to obtain the context menu. 

 

 
 

Then select "Close Order". Left-double-clicking on the open position in the "Trade" 

tab of the "Terminal" window will generate the same result. Next, the order window 

will appear. 
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Stop Loss and Take Profit Orders 

A Stop Loss is an order to close a previously opened position at a price less profitable 

for the customer than the price at the time of placing the order.  

A Take Profit is an order to close a previously opened position at a price more 

profitable for the customer than the price at the time of placing the order.  

 

If you place these types of orders you do not have to sit in front of your computer to 

wait for the outcome. "Take Profit" and "Stop Loss" orders will be executed 

automatically as soon as the price reaches order level. You can place Stop Loss and 

Take Profit at the time of making a deal filling in the "Stop Loss" and "Take Profit" 

fields in the "Order" window. 

 

 
 

To modify Stop Loss and Take Profit levels right click on the open position or on the 

pending order in the "Trade" tab of the "Terminal" window then select "Modify or 

delete order". 

 

Trailing Stop 

Once a trailing stop has been placed (for example, if a trailing stop's value is 15 pips) 

the following occurs: 

 

� No Stop Loss order will be placed until the open position is in a profit of at 

least 15 pips. MetaTrader 4 then sends an instruction to place the Stop Loss 

order 15 pips higher or lower than the current price.  

� Subsequently, each time the difference between the current price and the 

order level exceeds 15 pips, MetaTrader 4 sends the instruction to modify the 

Stop Loss order to a level 15 pips higher or lower than the current price. As a 

result, the Stop Loss order becomes closer to the current price. 
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Installing Expert Advisors 

Some trading robots come with automatic install packages which you just load to 

complete an installation. Other robots will require you to install manually, 

particularly free trading robots. Here is how to complete a simple install of a basic EA 

file. All that is involved is placing a file in the right place on your computer. 

 

Installation 

1. Download your Expert Advisor. When you download your Expert Advisor, 

make sure you save it somewhere you can find easily, such as your desktop. 

Alternatively, you can download it directly into the right place on your 

computer according to the instructions below. What you need to check if you 

do this is that your Expert Advisor is in its raw format and is NOT a zipped file. 

If it is a zipped file you will need to unzip it before it will function correctly.  

 

2. If your Expert Advisor is “zipped” (shows an image of a zipper on 

the file ) then you will need to unzip this. In Windows Vista this is 

done simply by clicking the “extract all” link and then specifying 

where you want the unzipped files to go to. If you do not have 

Windows Vista you may need to download an unzipping package 

like WinZip in order to extract the file(s) into a state you can work with.  

 

3. Now we need to get the Expert Advisor into your Metatrader. If you 

do not already have a demo or live account with a Metatrader 

broker you will need to get one. See here for how to open a demo 
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account.  

 

4. Copy your Expert Advisor file. This is the document that 

ends in “.ex4″ or “.mq4″ NOT the folder itself. Do this by 

right clicking on the file and clicking “copy”. 

 

5. Open up “my computer”. This will be located either on your desktop or in the 

“start” menu (bottom left of your screen). Then open up your hard drive, 

usually called “C:”. Look for a folder named “program files” and open that. 

Now search for Metatrader. It could be called “Metatrader” or the file name 

may start with your broker name, such as “FxOpen-Metatrader”. Either way, 

locate your Metatrader folder and double click to open it. When you have 

done this, look for a folder called “experts”. Open this too. 

 

 

 

6. Now, to complete the installation, just right click anywhere inside the experts 

folder screen and click “paste”. A popup box may appear asking for permission 

to continue, if it does just click ‘ok’. After a couple of seconds your new Expert 

Advisor file should show up in the list. You are done! 

 
 

7. Open Metatrader. If you have Metatrader open on your 

computer already, restart it. Check that the Expert 

Advisor is installed properly by looking at the “expert 

advisors” section on the left of your screen. If you do not 

see this click on “view”—->”Navigator”. If you have 

installed the Expert Advisor correctly it will show up in 
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this list. You are now ready to go, just drag the Expert Advisor onto the right 

charts and choose your settings. 
Source: http://www.donnaforex.com/metatrader/how-to-install-an-expert-advisor/364 

 

Activating Expert Advisors 

To activate an Expert Advisor in the trading platform, go to the Tools menu > select 

Options, then select the tab Expert Advisors. Click the boxes to: Enable the Expert 

Advisors and Allow Live Trading.  

 
 

MetaTrader 4 Advanced 

Using the Strategy Tester 

The Strategy Tester is a function in the Expert Advisor that allows you to back test 

your strategy according preset conditions. 

 

In order to test your strategy, first select View > Strategy Tester from the menu. 

Then select: 

 

1. The Expert Advisor you would like to test (drop list Expert Advisor) 

2. Parameters of the EA (Button Expert Properties) 

3. The currency pair on which it will be tested (drop list Symbol) 

4. The timeframe of the data to be used (drop list Period) 

5. The Model, knowing the “Every tick” usually gives the best modelling quality, 

but the “Control points” is the fastest (drop list Model) 
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6. “Optimization” is used to select an optimal set of parameters for EA (tick) 

7. “Visualization” is used to follow the positions taken by the Expert Advisor 

8. You can preset the testing period through “Use Date”. If no period is specified, 

the Strategy tester takes all the available data. 

 

If we run the Strategy Tester on the GBPUSD currency pair on the 1 hour timeframe: 

 
 

The results of the test can be seen in the worksheet Results, Graph or Report, each 

presenting the information in a different way: 

 

 
 

Or,  
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Hot Keys 

Here's the list of the hot keys available in MetaTrader 4. 

 

Hot key Function 

← chart scrolling to the left 

→ chart scrolling to the right 

↑ fast chart scrolling to the left or, if the scale is defined, chart scrolling up 

↓ fast chart scrolling to the right or, if the scale is defined, chart scrolling down 

Numpad 5 restoring of automatic chart vertical scale after its being changed. If the scale was 

defined, this hot key will return the chart into the visible range 

Page Up fast chart scrolling to the left 

Page Down fast chart scrolling to the right 

Home  move the chart to the start point 

End  move the chart to the end point 

- chart zoom out 

+ chart zoom in 

Delete  delete all selected graphical objects 

Backspace  delete the latest objects imposed into the chart window 

Enter  open/close fast navigation window 

Esc  close the dialog window 

F1 open this MetaTrader user guide 

F2 open the "History Center" window 

F3 open the "Global Variables" window 

F4 download MetaEditor 

F5 switch to the next profile 

F6 call the "Tester" window for testing the expert attached to the chart window 

F7 call the properties window of the expert attached to their chart window in order to 

change settings 

F8 call the chart setup window 

F9 call the "New Order" window 
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F10 open the "Popup prices" window 

F11 enable/disable the full screen mode 

F12 move the chart by one bar to the left 

Shift+F12 move the chart by one bar to the right 

Shift+F5 switch to the previous profile 

Alt+1 display the chart as a sequence of bars (transform into bar chart) 

Alt+2 display the chart as a sequence of candlesticks (transform into candlesticks) 

Alt+3 display the chart as a broken line (transform into line chart) 

Alt+A copy all test/optimization results into the clipboard 

Alt+W call the chart managing window 

Alt+F4 close the client terminal 

Alt+Backspace 

or Ctrl+Z 

undo object deletion 

Ctrl+A arrange all indicator windows heights by default 

Ctrl+B call the "Objects List" window 

Ctrl+C or 

Ctrl+Insert 

copy to the clipboard 

Ctrl+E enable/disable expert advisor 

Ctrl+F enable "Crosshair" 

Ctrl+G show/hide grid 

Ctrl+H show/hide OHLC line 

Ctrl+I call the "Indicators List" window 

Ctrl+L show/hide volumes 

Ctrl+P print the chart 

Ctrl+S save the chart in a file having extensions: "CSV", "PRN", "HTM" 

Ctrl+W or 

Ctrl+F4 

close the chart window 

Ctrl+Y show/hide period separators 

Ctrl+Z or 

Alt+Backspace 

undo the object deletion 

Ctrl+D open/close the "Data Window" 

Ctrl+M open/close the "Market Watch" window 

Ctrl+N open/close the "Navigator" window 

Ctrl+O open the "Setup" window 

Ctrl+R open/close the "Tester" window 

Ctrl+T open/close the "Terminal" window 

Ctrl+F6 activate the next chart window 

Ctrl+F9 open the "Terminal — Trade" window and switch the focus into it. After this, the 

trading activities can be managed with keyboard 
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11 General Tips & Tricks 
 

1. Need to get back to the current chart time in a hurry? Press the End key. 

2. Want to quickly reset the price scale to Auto? Double-click anywhere on the price 

scale. 

3. Not sure of a chart’s scale? The length of the dotted-line period separators for the 

Pivots program is 20 pips Cable, or equivalent other currency-pair (Pivot value +/- 

10 pips). 

4. To extend a line without moving it. Highlight it, then press & hold Shift before 

click & dragging an end-point. 

5. To copy a line. Highlight it, then press & hold Ctrl before click & dragging on any 

point. This gives a second, parallel, line with all the same attributes, e.g. colour, 

thickness... This applies, similarly, to any object, e.g. a price arrow or label, etc. 

6. To delete (custom) indicators from ALL charts. Open the Navigator window (View 

– Navigator) and expand the Custom Indicators folder. Right-click on the relevant 

indicator and select Delete, then close and re-open MetaTrader. This deletes the 

relevant program files, so is only recommended for custom indicators.  

7. To attach indicators to several charts. Open the Navigator window (View – 

Navigator) and expand the relevant folder (Indicators or Custom Indicators). Click 

& drag the relevant indicator into each chart window to attach it to as many 

charts as desired.  

8. If you have a favourite size for the overall MT Window that you want to keep, 

always remember to un-maximise the window before closing MetaTrader.  

9. If you experience a go-slow when MT4 is running. Reduce the maximum number 

of bars in the History and Charts. Go to Tools – Options – Charts tab and enter 

appropriate values (e.g. 10,000) for both options. Larger values are used to test 

trading strategies – they’re not required for our purposes. 

10. Pivots: It’s not just coincidence when R1 & S1 equal yesterday’s High & Low (and 

the Pivot value equals yesterday's Close). This occurs when a day’s Close equals 

the average of the day’s High and Low. 

11. If there is an anomalous spike of data that is clearly wrong (not shown in other 

program or platform data) you may delete it from the data history. Press F2 (or 

Tools – History Center) and select the relevant currency-pair and time-period. 

Scroll through the data to the relevant date & time, highlight the entry and Delete 

(or better yet, Edit and change incorrect values to reasonable values). These 

changes remain in effect until you refresh the chart or cause it to be refreshed, 

e.g. by scrolling back in a chart beyond the (currently) first (earliest) bar. 


